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Dear ArchiColleague:

Thank you for taking the time to get started right with ArchiCAD.

We believe that ArchiCAD is one of the best investments you can make in your firm's productivity 
and we are dedicated to assisting you in mastering and maximizing its capabilities.

Your goals: To dedicate and discipline yourself to learn Archicad in the shortest time possible; 

To become a Digital Architect.

Our goals: To collapse your learning curve to the shortest time possible;

To transmit years of technology and process knowledge, from our brains into 
yours, in the most efficient way possible.

Please take the time to read through this handbook, filled with recommendations and advice based 
on 16 years of ArchiCAD and digital architectural experience.

Feel free to contact us at any time if you need our help in any way. We are dedicated to assisting 
you become as successful as possible with ArchiCAD.

We hope this will be the start of a beautiful friendship!

Yours truly,

John Stebbins, Associate AIA Caitlin Leal
President, Digital Vision Automation, Inc. Director of Customer Communications and 

Service
714/865-4712 714/612-4547
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Getting the Most out of ArchiCAD
Procedures and Policies to Optimize Your Investment in ArchiCAD

Winning ArchiCAD Attitudes

• Your training goal is to get to the point where you can use ArchiCAD as a creative tool and 
as an extension of your mind. This takes time and dedication. Don’t give up.

• Inch by inch, anything’s a cinch. Be patient with yourself and never stop learning.
• You are building, not drafting. Virtual Building (referred to by the industry as Building 

Information Modeling, BIM) is what ArchiCAD is all about.
• Don’t worry; you can create anything you want, as long as you know how. And we are here 

to show you how.
• Just like in the construction process, some things are easy to build and other things are more 

difficult to achieve. The same is true in ArchiCAD. Don’t expect everything to come at the 
press of a button. Like any tool, you have to learn to use it creatively.

Got Questions?

Digital Vision Quick-Contact Guide
Contact Role Phone e-mail
John Stebbins Sales/Training 714/865-4712 (cell) john@digitalvis.com
Caitlin Leal Sales/Customer 

Relations
714/612-4547 caitlin@digitalvis.com

Kevin Poulsen First-line 
Training/Tech 
Support

602/361-7799 kevin@undecillion.com

Graphisoft Boston NA Headquarters 800/344-3468
Graphisoft Tech 
Support

Escalated Tech 
Support 

800/238-3992 support@graphisoft.com

Tech support vs. Training support
To get your questions answered in the most efficient way possible, it is important to know if your 
question is training related or technical. A training question is related to "how to" do a certain 
procedure in ArchiCAD (How do I edit a slab?). Technical questions have to do with ArchiCAD
performance or its interface with other devices (My ArchiCAD freezes upon launching the 
program. What do I do?).
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• For training-related and “how-to” questions, call Kevin at 602/361-7799 or e-mail him at 
kevin@undecillion.com.

• For technical support questions, call Graphisoft at 800/238-3992 (available from 8:30 a.m. to 
8:00 p.m.). You can e-mail your questions to Graphisoft Tech Support at 
support@graphisoft.com. Important: to make sure your question is answered, we 
recommend that you take the responsibility to follow-up via phone or e-mail. Keep contacting 
until your question is answered; don’t give up.

• For customer service and sales-related questions or comments, call Caitlin at 714/612-4547 or 
e-mail her at: caitlin@digitalvis.com.

Three Strikes and You’re In
Digital Vision has a “Three Strikes and You’re In” training support policy. Here is the procedure 
we would like you to adopt if you can’t get an ArchiCAD task accomplished:
1. Try it; if it doesn’t work the first time…
2. Try it again; if it doesn’t work the second time…
3. Check the manual or go the “Help” menu to figure out on your own how to achieve your 

objective.

If, after the third “strike” you can’t get the procedure to work, call or e-mail Kevin at the above 
number.

No Spin (Your Wheels) Zone
Please don’t spin your wheels! After exhausting the above attempts, please contact us. Our goal is 
to keep you moving forward with our assistance when you really need it, but to help you become 
as self-sufficient as possible so that you don’t have to become overly dependent on us. If you have 
questions that can wait, write them down and bring them to the regular User Clinics.

What is GSReport (Bug Reporter)
GSReport (Bug Reporter) is a mini-program created by Graphisoft and available since version 
6.5, found in your ArchiCAD folder, that you can run when instructed by Graphisoft Tech 
Support or when you crash. This program gleans valuable information from your computer and its 
settings that assists them in troubleshooting your computer and could lead them in discovering 
what might be the source of conditions where ArchiCAD crashes or performs irregularly. For 
more information, read the “About GS Bug Reporter” document in the ArchiCAD folder

Learn More On-line
• www.digitalvis.com: click on “Support” 
• ArchiGuide Online: www.archiguide.com
• User TechTips: http://www.graphisoft.com/support/Archicad/archiguide/techtips.html
• www.graphisoft.com: click on the “Support” tab and choose “ArchiCAD”
• Archicad Technical Resource portal: http://tr.graphisoftus.com

Archicad-Talk Knowledge Exchange Forum
“Archicad-Talk” is a world-wide ArchiCAD on-line forum, a free on-line user group where you 
can pose questions and get answers from across the world. You can join Archicad-Talk Forum by 
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registering yourself on the http://Archicad-Talk.Graphisoft.com web site by clicking on the 
“Register” button on the upper right of the main Archicad-Talk web page.

Mastering ArchiCAD, a 12 Step Program

1. Attend a JumpStart Training. We include a 7-hour complementary hands-on “Jump-Start” 
basics training with the purchase of ArchiCAD, held monthly in Irvine & San Diego, CA and 
Scottsdale, AZ.

2. Transfer your CAD skills from other programs to Archicad skills. CAD principles are CAD 
principles…its just that different programs have different buttons terminology to accomplish 
the same things. Read our “Autocad/Archicad Cross-Training Guide.”

3. Start the ArchiCAD 10 Interactive Training Guide workbook. Install the Training Guide 
files from Disk 2. It will place both Training Guide 1 & 2 menu items under the Help menu 
where you can conveniently launch them. Hint: click on the QuickTime icons to play movies.

4. Start your first project by simply creating walls, doors, windows, slabs and furniture. Leave 
the roofs for later. Keep it simple, yet begin being productive.

5. Attend monthly User Clinics. Start attending Digital Vision’s monthly ArchiCAD User 
Clinics. Consider the clinics free training and regular professional advancement.

6. Download tips and tutorials from www.digitalvis.com. Click on “Support” and 
“ArchiCAD Tips and Tricks.” Start a personal ArchiCAD 3-ring binder notebook.

7. Take advantage of on-line learning. Bookmark and visit:
• ArchiGuide at http://www.graphisoft.com/support/Archicad/archiguide, 
• the FAQ section of http://tr.graphisoftus.com and 
• Archicad-Talk at http://Archicad-talk.graphisoft.com regularly.

8. Complete the ArchiCAD 10 Interactive Training Guide workbook. This will be your 
Intermediate self-training experience and will round out your over-all knowledge.

9. Get some in-house custom training. “No Train, No Gain:” Schedule a custom in-house 
Intermediate or Advanced Training series with Digital Vision.

10. Start setting up your office templates based on those found in ArchiCAD
Templates/Additional Templates/MaxATS in your ArchiCAD folder (for assistance, print out 
and read Intro to Office Standards in the Graphisoft Documentation folder on your 
ArchiCAD install CD). For the latest version of the MaxATS templates, visit the Support > 
Downloads section of www.digitalvis.com
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11. Take advantage of “Project Assistance.” We’ll hold your hand on a consulting basis on 
your first project. Once you complete an entire project in ArchiCAD and PlotMaker, the 
major learning curve will be behind you and the virtual building process will be internalized.

12. Complete your first full project, by using ArchiCAD throughout the entire architectural 
process: schematic design, design development, presentations and working drawings. 

Repeat the Initial “JumpStart” Training
You may repeat this beginning class as many times as you want, or send new employees, as long 
as space permits. Call Caitlin at 714/612-4547 to pre-register and to verify the class will be held.

Jump Start Training Schedule and Locations (check our web site for dates):
• San Diego

9:00 a.m.–4:30 p.m.
Office of Christopher + Kacur Architects
2150 W Washington, Ste. 501, San Diego

• Orange
9:00 a.m.–4:30 p.m.
Thompson Building Materials Design Center
1716 Case St., Orange

• Scottsdale, AZ
9:00 a.m.–4:30 p.m.
Office of Digital Vision Automation, Inc.
7047 E. Greenway Pkwy, Ste. 250, Scottsdale

Attend our FREE monthly User Clinics to tune-up your ArchiCAD skills.
Push your limits, hone your skills, get answers to all of your questions, share your work, see what 
others are doing, enrich your self and others, have fun…
• Costa Mesa: first Thursday of every month

6:00 p.m. to 8:00 p.m.
Irwin Pancake Architects, 245 Fischer Ave., Ste. B2
(for more information, call Melisa Pence at 949/370-6037)

• San Diego: second Tuesday of every month
6:00 p.m. to 8:00 p.m.
SPACE San Diego, 1531 Pacific Highway (across from the Star of India tall ship)
(for more information, call Phil Feinberg, User Clinic coordinator, at 619/309-9202)

• Phoenix: second Wednesday of the month
6:00 p.m. to 8:00 p.m.
Office of Digital Vision Automation, Inc., 7047 E. Greenway Pkwy, Ste. 250, Scottsdale
(for more information, call Brian Rice, User Clinic coordinator, at 480/609-0699)
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Get Some Custom ArchiCAD Training…“No Train, No Gain”
Have laptops, will travel. We’ll set up a training lab in your office. You provide the conference 
room and we provide the computers, projection system and training materials. One to four-day 
hands-on training programs are available, customized to meet your needs. $750 per day.
Visit: http://www.digitalvis.com/other_training.php for details. Call Caitlin at 714.612.4547 to 
book your time with one of our instructors.

Project Assistance
Let us help you get started right on your first project. Call it professional hand holding. Once you 
understand ArchiCAD concepts and grasp the creative tools via our classes and clinics, you are 
ready to put your first project in the system. Once you get your first project in, you will be over 
the learning “hump” and your investment will really start to pay off. Call Digital Vision to book 
your time.

Read Additional Books on ArchiCAD

• Step by Step Book & CD for ArchiCAD 10, $59.00 (available from Digital Vision)
• Virtual Tutor for ArchiCAD 9 Training DVD, $120.00  (available from Digital Vision)
• Illustrations in ArchiCAD, $25.00 (available from Digital Vision)
• GDL Cookbook (available from Objects Online)
• Intro to Office Standards (in the Graphisoft Documentation folder on your Archicad 9 install 

CD or download from the www.digitalvis.com web site)
• Migration Guide (free download from the www.digitalvis.com web site)
• Project Framework, $49.00 (available from Objects Online)

Dedicate Yourself to Lifelong Learning
One of the great spin-offs of the high-tech digital revolution is that it necessitates a commitment 
to lifelong learning, given the ongoing evolution of the computer industry. If you are an AIA 
member, all of your learning experiences (Digital Vision trainings, User Clinics, tutorials, etc,) 
qualify for AIA LUs for your professional advancement.

Get Some Basic Computer Training
Think of your computer as your Virtual Office. You need to know how to properly run your 
office. You must be grounded in basic computer knowledge to take advantage of any CAD 
program and the other software tools necessary to run your office. Therefore, if you are new to 
computing and need to learn general computing skills, check with your local community college. 
They usually have low-cost introductory computer classes. Also, pick up a good introductory 
computer book based on the kind of computer and operating system you are using like:
Macs for Dummies or Windows for Dummies, both by IDG Books.
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Digital Vision/Graphisoft Policies

What Keys Are For
ArchiCAD protection keys, sometimes referred to as dongles, enforce the copyright laws. Many 
high-end CAD companies deploy these devices to prevent illegal use of their software (e.g. 
formZ, 3D Studio Max, etc.) ArchiCAD will only launch if a key is properly plugged into a port 
on your computer. You can copy ArchiCAD on as many computers as you want, but it will only 
run on a computer where a key is present. Since version 7.0, Graphisoft has changed key venders. 
We now use keys manufactured by Wibu (www.wibu.com). The USB version of these keys can 
be used on Macs and PCs interchangeably. 

What to Do If Your ArchiCAD is Lost or Stolen 
As of April 2001, Graphisoft adopted following policy in regards to lost or stolen Archicad keys: 
The purchase of a license is intended for the perpetual use of ArchiCAD! The software, manuals, 
and serialized hardware protection device that comprise ArchiCAD represent a considerable 
investment in your business. In the unfortunate event that your software, protection key, or 
manuals are lost, stolen, or destroyed, you can purchase a replacement protection key and manual 
set for $100 each. To obtain this, you must provide Graphisoft with a notarized letter on your 
company letterhead from a principal or officer at your firm, citing the approximate date the 
item(s) was lost, stolen, or destroyed, and a guarantee that it will never be used again. In the case 
of a theft, a copy of the police report is also required. Additionally, please indicate the ArchiCAD 
version, including the key number, if possible.

What to Do If Your Key Goes Bad or Malfunctions
If you consistently get a message that states “protection key not responding,” please contact 
Graphisoft directly and they will send you a replacement key via overnight mail.

Upgrades and Updates
About every year and a half, Graphisoft releases a major upgrade to ArchiCAD, which adds 
many new features and capabilities. Over the years, the average cost of upgrades has ranged 
between $600 and $700; these upgrades are released every year to year and a half.

From time to time between major upgrades, Graphisoft issues updates that fixes bugs and 
anomalies and improves efficiency and sometimes adds a few additional features. Updates are free 
to those who have the current version of ArchiCAD. Updates are always issued on-line for 
download at tr.graphisoftus.com. To check to see if you have the latest update, go to the Help 
menu and choose “Check for updates.” Keys are upgraded electronically via 
https://upgrade.graphiosft.com.

Using Previous Versions of ArchiCAD with Your Current Key
Your current ArchiCAD key is designed to work with the current version of ArchiCAD. You 
cannot run a current version with an old key; you cannot run a pervious version with a current 
key. However, located in a folder called “Support” on your installation CD are folders containing 
the last few versions of ArchiCAD that will run with a current key, enabling you to open older 
projects with a previous key, even though you have sent in your older key(s) when you upgraded.
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Transferring or Selling Your ArchiCAD License
Graphisoft permits the transfer of ArchiCAD licenses, usually paid by the person to whom the 
license is being transferred to. If you wish to sell or transfer your license, the seller must draft a 
letter to Graphisoft stating that license/s are being transferred, with key numbers, the name, 
address, phone and e-mail of the person/firm the software is being transferred to. This letter 
should then be sent to Digital Vision and we will forward it to Graphisoft. Please advise the buyer 
that the fee for transferring a license is $475. Please contact Digital Vision to facilitate the transfer 
process.

Referral Program: Help Us Spread the Word
If you refer a prospect to Digital Vision, we offer an incentive program that awards you “Digital 
Vision Credits” for each prospect referred that we have not already contacted. If that prospect 
buys ArchiCAD, then you will receive additional credits.

Prospect Referred = 50 DV credits
Prospect Referred & Closed = 200 DV credits

Credits are equal to one dollar that you can use to apply towards any of your CAD-related needs, 
including ArchiCAD libraries, add-ons, training sessions, upgrades, or even additional sites. 
Credits have no cash value. We maintain a spreadsheet running total of your referral credits.

You will find a Referral Form at the end of this handbook.

Recommendations

Beware of the “Brain Drain”
In a multiple person office, we would like to caution you about one or two people only 
maintaining the knowledge of ArchiCAD and your CAD office standards. What would happen if 
these “Knowledge Gatekeepers” were to leave or you had to let them go? With them would go 
one of your firm’s greatest assets: the knowledge of how your firm’s information systems are 
maintained and organized, including CADD operations. This we call the “Brain Drain.” To guard 
against this, we recommend that all architectural personal, especially the principals, learn 
ArchiCAD and have at least an intermediate level of CADD competence. Then, you will not be as 
dependent on “Knowledge Gatekeepers.”

Create Your Office Standards
Owning the best architectural CADD system in the world only gets you to maybe 50% of your 
ultimate office automation efficiency. The other 50% is based on how you use the CADD system 
and the how is all about creating office standards and procedures. We recommend that you 
establish a CADD Procedures Manual for your office. Please use the “CAD Office Standards 
Manual” outline in the Appendix to get started.

Font Recommendations
ArchiCAD can recognize any TrueType font you load into your operating system. If you are 
looking for an architectural hand-drawn font, consider the time-honored “Tekton” from Adobe 
(based on the hand lettering of West Coast architect Frank Ching), available at 
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www.linotype.com. Another popular architectural font is “Frank Lloyd Wright Eagle Feather,” 
available from P22 Type Foundry, www.P22.com. 

Digital Vision recommends that if you choose hand-lettering fonts, use them for preliminary 
presentations and not for working drawings, which are technical documents. Since we are now in 
the “age of collaboration,” demanding file exchange with a variety of consultants and collaborates, 
use Arial or Times New Roman. They are easy to read and everyone has them on their computer, 
so there will be no need for font substitution that can cause “text shift” when CADD files are 
exchanged.

3rd-Party Add-ons and Library Objects
Contact Digital Vision for advice on how you can expand ArchiCAD’s capabilities via add-ons. 
There are thousands of library parts available world-wide to expand your object collection. We 
can advise you on libraries and add-ons to meet your needs. We are dealers for many of these 
add-ons and library collections.

Where to Get More Objects
• Directly from Digital Vision
• www.objectsonline.com
• www.gdlcentral.com
• www.webscape.com/GDL/GDL.html or call 626/793-7400 (they can create any custom

object you desire; located in Pasadena)
• Learn to make your own GDL library parts by creating objects on-screen (download “How to 

Create Custom Library Parts” from the Digital Vision web site) or through scripting 
(download “A Taste of GDL” from the Digital Vision web site, both found in the 
Support/Archicad Tips and Tricks section). Come to one of our periodic GDL classes. Join 
the GDL Alliance at www.gdlalliance.com, a world-wide movement of GDL authors and 
aficionados, co-founded by John Stebbins of Digital Vision.

Backing Up
We recommend that you back up your ArchiCAD and other important files regularly. For short-
term back-up, secondary hard disks or DAT tape should be considered. We feel that the best 
long-term media for backing up files are CD ROMs. If your computer does not have a CDRW 
drive, we suggest that you get a CD ROM “burner” (they are so inexpensive now and CD ROM 
disks are very cheap). The file formats we recommend for long-term, multi-redundant storage of 
completed projects are:
• An ArchiCAD archive file of each project’s “virtual building” (these are .pla files created via 

the “Save as “command from the File menu)
• .plt files of your PlotMaker sheet layouts (these are generic HPGL2 files)
• .pdf files of your sheet layouts (these are universal PostScript files)
• Keep two copies of your important files and maintain one set of copies offsite (preferably a 

safe deposit box or at home), to protect against fire or theft.

Have a Back up Computer Available
You are now a digital architect and depend on having digital tools available to you at all times. If 
you are a sole proprietor of a small office, make sure you have another computer available to you 
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to run ArchiCAD in case your primary computer goes down. Best yet, make that computer a 
laptop.

Consider a Laptop Computer
ArchiCAD and a laptop computer create a mobile virtual architectural office! Now you can create 
anywhere and have a great multimedia platform for presenting your ideas to your client. Laptops 
(now called notebooks and many models are now marketed as desktop replacements) are very 
powerful and are now relatively inexpensive. Minimum recommended configuration: 15 inch 
screen, 2 GB RAM, OpenGL video card with 128 MB video RAM, 100 GB hard drive running at 
7200 RPM if possible, a 600+ front side buss (FSB), a P4 or AMD Athlon processor, running at 2 
plus GHz (or G5 PowerBook or MacBook Pro)., plus two min. USB 2.0 ports.

Also add a mouse, a keyboard, and a large monitor (or flat panel) for desktop use. At Digital 
Vision, we now do all our work and training via laptops…no more dinosaur desktops and 
monstrous monitors to drag around.

An added feature of working on laptops is that they have batteries, which means that if there is a 
power brown out/black out, you have a built-in uninterrupted power supply.

Retain a Computer Consultant
Every office needs someone they can turn to locally when their computer, network, or the 
operating system lets you down. We recommend that you have a consultant that you can turn to 
at all times who can help you troubleshoot or fix your computer, set up and maintain your 
network, set up and fine tune your plotter, etc. Digital Vision’s role is to help you integrate 
ArchiCAD into your work flow and even though we know a lot about computer troubleshooting 
and welcome your questions, please don’t rely on us to provide this function, since it is not our 
focus. We are aware of many fine computer consultants and systems integrators, so feel free to 
call us for recommendations in your area.

Fine Tune Your Plotter Before You Are On Deadline
When you get your first plotter or replace your old one, with the assistant of the company you 
bought it from or a networking professional, set it up and do some test plots before you are on 
deadline. Plotters are very technical and often finicky animals, so test your plotter on a few 
existing drawings or test sheets to make sure that plotter drivers are properly configured, line 
weights are correct and the plotter settings are configured properly at its menu panel. This will 
save you much frustration and embarrassment, so don’t wait until you are under the gun to set up 
your plotter. 

Collaborating With Other ArchiCAD Users
If you need to collaborate with others, the two most popular ways to exchange files is with Zip 
disks or CD ROM’s. Flash USB memory sticks are also becoming popular (our favorite exchange 
device; they’re cheap, fast, small, and really handy).

When exchanging files with other ArchiCAD users off site, make sure you make an Archive of 
your ArchiCAD project file (Save as… from the File menu and choose from the “Save as type:” 
pop-out menu “Archicad Archive Project”). An Archive consolidates your project, with all of the 
library parts you have used, into one file (creates a project file using the .pla file format). 
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Consider a 3-button Mouse (if you are a Mac user)
One of the nice things about the Windows environment is that you can use the right mouse button 
to click on things and get context-sensitive menu choices at your cursor. This same capability 
comes on a Mac if you Control-click, but if you get a 3-button mouse for your Mac, you can 
program the right button to act as if the Control button is held down while you are clicking on 
something, creating the effect of a right-click.

Expand Your Office with ArchiCAD
Contact Digital Vision when it's time to expand your office. We can provide:
• Additional licenses.
• Network keys.
• Leasing and financing available.

Classified Ads
Looking for work or need assistance? Have something computer-related to sell? Digital Vision 
maintains a free classified section on its web site. Go to www.digitalvis.com and click on 
"Classified." Fill in the on-line form and we’ll post your classified ad ASAP.

Becoming a Digital Architect
Becoming a Digital Architect is a worthy and desirable goal. Being in command of ArchiCAD will 
take you a long way down this path, but you will get to the point where you will need to master 
complementary software as well. We recommend that you make it your goal to learn (or have 
someone in your office learn) the following software, to “round out” your digital capabilities:

Software Capabilities Price
Artlantis Render higher-level rendering capabilities $595
Adobe Photoshop image editing and photomontage for screen, web or 

print (cmyk)
$599

Piranesi Photoshop for Architects on steroids; allows you 
to create your won hand-drawn or painted styles 
for an “impressionistic” look

$645

Adobe Photoshop 
Elements

image editing and photomontage for screen or web 
only (no cmyk)

$99

Adobe Acrobat creating scalable drawings, images, or documents 
that can be opened or printed from any computer

$219

Adobe Illustrator graphic design, logos $389
QuickTime Pro movie editing $29
QuickBooks Pro accounting, invoicing, financial analysis $195
Architecture Information 
Manager

Business management, control paperwork, project 
costs, time cards, billing, etc.

varies

Microsoft Powerpoint or 
Keynote (Mac)

slide shows and client presentations

Microsoft Word correspondence, contracts, specifications, 
transmittals, etc.

$450, all 
bundled as 
Microsoft 
Office XP
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Microsoft Excel cost analysis, schedules

NOTE: The above policies, procedures and prices are subject to change without notice. With 
change being the only constant, change they will. Always contact Digital Vision for updated 
policy information.
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Help Digital Vision continue the ArchiCAD momentum 
DIGITAL VISION CUSTOMER REFERRAL FAX-BACK FORM

FAX to: 866/817-1899
or mail to address below

My following colleague(s) could benefit from ArchiCAD. Feel free to use my name when you 
make contact.

___________________________________ _______________________
Your name: Your phone:
-------------------------------------------------------------------------------------------------------------

Name of referral:

Firm name: Phone:

The following information would be helpful to us, but only if you have it handy:
E-mail:

Address:

City: State: ZIP:

Relationship to referral:
Type of projects they do:
Software currently owned?

-------------------------------------------------------------------------------------------------------------

Name of referral:

Firm name: Phone:

The following information would be helpful to us, but only if you have it handy:
E-mail:

Address:

City: State: ZIP:

Relationship to referral:
Type of projects they do:
Software currently owned?
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-------------------------------------------------------------------------------------------------------------

Name of referral:

Firm name: Phone:

The following information would be helpful to us, but only if you have it handy:
E-mail:

Address:

City: State: ZIP:

Relationship to referral:
Type of projects they do:
Software currently owned?

NOTES:


